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Installation overview
Single

classroom
School or
district

Task Reference

Ensure your computers and network meet the
SMART Sync™ classroommanagement software
minimum requirements.

page 2

Select a type of installation:
l Single classroom

l School or district wide

page 3

Install SMART Sync Class List Server. page 15

Install SMART Administrator Tools - Classlist
Manager.

page 16

Optionally, export information from third-party
applications to CSV files.

page 16

Create a SMART School (.school) file. page 20

Install SMART Sync Teacher software on teacher
computers and SMART Sync Student software on
student computers.

page 6
OR
page 29

Optionally, configure SMART Sync Student software. page 8

L   L I NKS

Please send any feedback on this guide to DocumentationFeedback@smarttech.com.
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Chapter 1: Getting started
Computer and network requirements 2

Teacher and system administrator computers 2
Student computers 2
Network 2

Selecting a type of installation 3
Single classroom installation 3
School- or district-wide installation 4

This guide explains how to customize and deploy SMART Sync classroommanagement software.

This guide is intended for IT administrators and others experienced with customizing, deploying and
administeringWindows® software in a networked environment. To use this guide, youmust:

l Know IT terminology such as “registry” and “domain controller”

l Know how to complete basic administrative tasks inWindows operating systems such as
modifying the registry

l Have administrative privileges and access to servers

l Have Internet access

I   I MPORTANT

Youmust run the commands documented in this guide in anAdministrator Command Prompt
window. To open anAdministrator Command Prompt window, right-click theCommand Prompt
icon, and then select Run as Administrator.
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Computer and network requirements
Before you install SMART Sync software, ensure your computers meet theminimum requirements
defined in this section.

N   NOTE

In addition, review the recommended settings for your computers and networks onRecommended
computer and network settings on page 49.

Teacher and system administrator computers
l Pentium® 4 processor

l 256MB of RAM

l 100MB of free hard disk space

l Windows XP, Windows Vista® orWindows 7 operating systems

l 800 × 600 or higher resolution display with 16-bit color quality

l Internet Explorer® Internet browser 5.0 or later

l DirectX® technology 7.0a or later

Student computers
l Pentium 4 processor

l 128MB of RAM

l 55MB of free hard disk space

l Windows XP, Windows Vista orWindows 7 operating systems

l 600 × 480 or higher resolution display with 16-bit color quality

l Internet Explorer Internet browser 5.0 or later

l DirectX technology 7.0a or later

Network
l 802.11 a/g wireless network (100Mbps wired network or 802.11 n wireless network

recommended)
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Selecting a type of installation
SMART Sync software consists of four components:

Component Purpose Typical location
SMART Sync Teacher
software

Enables teachers to connect with
students and other teachers

Teacher computers

SMART Sync Student
software

Enables students to connect with
teachers

Student computers

SMART Sync Class List
Server

Connects teacher and student
computers

Server accessible to all
teacher and student
computers

SMART Administrator Tools
- Classlist Manager

Enables teachers and system
administrators to create and edit
SMART School files, which are central
repositories of student, teacher, class,
computer lab and computer
information, and application and
Internet blocking rules

Teacher or system
administrator computers

N   NOTE

SMART Sync Class List Server and SMART Administrator Tools - Classlist Manager are optional.
You don’t need to install them to use the teacher and student components. However, there are
benefits to installing them.

Which of these components you install depends on whether you’re implementing SMART Sync
software in a single classroom or across your school or district.

Single classroom installation
A single classroom installation includes two components: SMART Sync Teacher software and
SMART Sync Student software.

l The teacher creates his or her own teacher ID, classes, application blocking rules and Internet
blocking rules andmanages the class with SMART Sync Teacher software.

l Students connect to the teacher through SMART Sync Student software by selecting the
teacher’s ID from a drop-down list or by entering the teacher computer host name or IP
address.

See Installing the software in a single classroom on page 5 for instructions on completing this type of
installation.
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N   NOTE

Although this type of installation is preferable if you’re installing SMART Sync software in a single
classroom, complete the procedures for a school- or district-wide installation if you’re considering
installing SMART Sync software in other classrooms in the future.

School- or district-wide installation
A school- or district-wide installation includes all four components of SMART Sync software.

Teachers and students connect to each other through SMART Sync Class List Server.

Unlike in single classroom installations, in school- or district-wide installations, teacher IDs, classes,
application blocking rules and Internet blocking rules are centrally managed in SMART School files
created with SMART Administrator Tools - Classlist Manager. This makes this type of installation
ideal for implementing SMART Sync software across your school or district.

See Installing the software across a school or district on page 13 for instructions on completing this
type of installation.
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Chapter 2: Installing the software in a single
classroom
Installing the software 6

Installing SMART Sync Teacher software 6
Installing SMART Sync Student software 6
Deploying the SMART Sync software installation packages 7

Connecting students to teachers 7
Configuring SMART Sync Student software 8

Running the SMART Sync Student Configuration Tool 8
Automatically configuring SMART Sync Student software 11

In a typical single classroom installation, you install SMART Sync Teacher software on one or more
teacher computers and SMART Sync Student software on student computers.

Teacher

SMART Sync 

Teacher

Student

SMART Sync 

Student

Student

SMART Sync 

Student

Student

SMART Sync 

Student

After installation, the teacher creates his or her own class and application and Internet blocking rules
in SMART Sync Teacher software. The students connect to the teacher by selecting the teacher’s ID
from a drop-down list or by entering the teacher computer host name or IP address in SMART Sync
Student software. However, you can change the connection option if necessary by configuring
SMART Sync Student software.
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Installing the software
If you’re installing SMART Sync software on a small number of computers or if teachers and students
are responsible for installing software on their own computers, use the installation wizards to install
the software.

You can start the installation wizards by downloading executable (.exe) files from the
SMART Support website.

Installing SMARTSync Teacher software

g To install SMART Sync Teacher software

1. Go to smarttech.com/software.

2. Scroll toSMART Sync classroommanagement software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Click Downloads, click theDownload button in the teacher software section, and then follow
the on-screen instructions to download the SMART Sync Teacher software executable file.

4. Double-click the executable file.

The SMART Sync Teacher software installation wizard appears.

5. Follow the on-screen instructions.

6. Click Install.

Windows Installer installs SMART Sync Teacher software.

Installing SMARTSync Student software

g To install SMART Sync Student software

1. Go to smarttech.com/software.

2. Scroll toSMART Sync classroommanagement software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Click Downloads, click theDownload button in the student software section, and then follow
the on-screen instructions to download the SMART Sync Student software executable file.

4. Double-click the executable file.

The SMART Sync Student software installation wizard appears.
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5. Follow the on-screen instructions.

6. Click Install.

Windows Installer installs SMART Sync Student software.

Deploying the SMARTSync software installation packages
If you’re installing SMART Sync software on a large number of computers, you can deploy the
installation packages to the teacher and student computers as documented in Installing the software
across a school or district on page 13.

Connecting students to teachers
After you install SMART Sync Teacher software on the teacher computer and SMART Sync Student
software on student computers, students can connect to the teacher computer through the software.

By default, SMART Sync Student software starts in visible mode when a student first logs on to his
or her computer. The student then enters his or her ID and connects to the teacher computer by doing
one of the following:

l Selecting the teacher’s ID from a drop-down list of teachers currently logged on to
SMART Sync Teacher software if multicasting is enabled on your school’s network

l Entering the host name or IP address of the teacher computer if multicasting isn’t enabled on
your school’s network

T   T I P

Teachers can determine the IP address of their computers by selectingHelp >
About SMART Sync in SMART Sync Teacher software.

In some classrooms, students always connect to the same teacher or teacher computer. For these
situations, you can configure SMART Sync Student software to connect to a specified teacher ID,
host name or IP address rather than require the students to provide this information each time they log
on.

For more information, seeConfiguring SMART Sync Student software on the next page.
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Configuring SMART Sync Student software
Run the SMART Sync Student Configuration Tool to configure SMART Sync Student software on a
student’s computer. The SMART Sync Student Configuration Tool updates the local machine registry
on the student’s computer.

Running the SMART Sync Student Configuration Tool
If you want to configure a SMART Sync Student software installation, run the SMART Sync Student
Configuration Tool.

g To run the SMART Sync Student Configuration Tool

1. Select Start > All Programs > SMART Technologies > SMART Tools > SMART Sync
Student Configuration Tool 2011.

The SMART Sync Student Configuration Tool appears.

2. Click Next.

3. In the Interface page, select one of the following options, and then click Next.

Option Select this option to:
Visible to students Show the SMART Sync Student software user interface to the

student.
Hidden from students Hide the SMART Sync Student software user interface from the

student.

N   NOTE

If you select Hidden from students, the student won’t be able to do the following:

o Connect to a teacher by selecting the teacher’s name from a list

o Manually start SMART Sync Student software

o Manually enter an ID after starting SMART Sync Student software

The relevant controls in SMART Sync Student Configuration Tool will be disabled or hidden.
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4. In theStartup page, select one of the following options:

Option Select this option to:
Allows the student to
select from a list of
available teachers

Allow the student to select a teacher from a drop-down list using
teacher discovery.

N   NOTE

This option is disabled if you clickedHidden from student in
step 3.

Automatically connects
with this Teacher ID

Connect SMART Sync Student software to a specific teacher
through the teacher’s ID.
Type the ID in the box below the option.

Automatically connects
with this hostname or IP
address

Connect SMART Sync Student software to a specific teacher
computer through the host name or IP address.
Type the host name or IP address in the box below the option.

N   NOTE

If your network uses DHCP, refer to the computer by host
name rather than by IP address.

Automatically connects Connect SMART Sync Student software to a specific teacher
specified in a SMART School file.

5. If you selectedAllows the student to select from a list of available teachers and want to
use SMART Sync Class List Server for teacher discovery, or if you selectedAutomatically
connects, select theUses this Class List Server host name or IP address check box.

Type the host name or IP address of the SMART Sync Class List Server computer in the box
below the check box.

N   NOTE

If your network uses DHCP, refer to the SMART Sync Class List Server computer by host
name rather than by IP address.

6. If the computer has multiple network adapters, click Network Adapter Selection to specify
the order of the network adapters.

7. Click Next.

8. In theOptions page, clear theStart SMART Sync Student automatically check box if you
don’t want SMART Sync Student software to start when the student first logs on.

N   NOTE

This check box is disabled if you selectedHidden from student in step 3.

CHA PT ER 2

Installing the software in a single classroom

9



9. Select the check boxes for the options you want to enable, and then click Next.

Check box Select this check box to:
Ask questions Allow the student to ask questions through

SMART Sync software.
Chat Allow the student to chat with other students through

SMART Sync software.
Submit files Allow the student to submit files through SMART Sync

software.
Exit the Student program Allow the student to close SMART Sync Student software.

N   NOTE

These check boxes aren’t visible if you clickedHidden from student in step 3.

10. In theStudent ID page, select one of the following options, and then click Next.

Option Select this option to:
Student Controlled Allow the student to enter an ID when SMART Sync Student

software starts.

N   NOTE

This option is disabled if you selectedHidden from student
in step 3.

The following Enter a specific student ID.
Type the ID in the box to the right of the option.

Found in this
Active Directory field…

Find the student ID in an Active Directory® directory service
field of the student’s login account.
Type the field name in the box to the right of the option.

Anonymous Allow the student to use SMART Sync Student software
without entering an ID.

11. In theShared Files Folder page, select one of the following options, and then click Next.

Option Select this option to:
My Documents folder Store files the teacher shares with the student in the

My Documents folder (Windows XP andWindows 7 operating
systems) or theDocuments folder (Windows Vista operating
system).

Custom folder Store files in another folder.
Type the path to the folder in the box below the option.
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12. In theSecurity page, select one of the following options, and then click Next.

Option Select this option to:
No security Allow any teacher with SMART Sync Teacher software to

connect to the student.
Allow only teachers with
this class password

Allow only teachers who enter a specified password in
SMART Sync Teacher software to connect to the student.
Type the password in the two boxes to the right of the option.

Allow only Teachers who
are part of the following
group(s)

Allow only teachers in certain groups to connect to the student.
Select the groups in the box below the option.

13. Click Finish.

TheRestart Required to Apply Settings message appears.

14. Click OK.

Automatically configuring SMART Sync Student software

C   CAUT ION

Use caution when you open theWindows registry editor. If you incorrectly modify theWindows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.
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After you configure SMART Sync Student software on one student computer you can apply the same
configuration to other student computers by exporting theSMART Sync Student registry key
(located inHKEY_LOCAL_MACHINE\SOFTWARE\SMART Technologies) to a file, and then
importing the file on the other student computers.

The SMART Sync Student Configuration Tool modifies the following registry values in theSMART
Sync Student registry key:

l Visible

l AutoStart

l ConnectTeacherID

l ConnectIP

l StoreFilesToMyDocs

l CustomSharedFolder

l RedrawHooks

l MirrorDriver

l UnicastNoDelay

l MulticastTTL

l EnableChat

l EnableQuestions

l EnableFileTransfer

l EnableHelp

l DisplayExit

l BroadcastZoomWindow

l CtrlAltDelSettings

l NICListLength

l PasswordHash

l NamingServerLoc

l NamingServerPassedTest

l SecurityUsed

l ConnectionUsed

l StudentIDMode

l StudentID

l ActiveDirStudentIdField

l EnableNICDefaultOrder

l NTGroupListLength
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In a typical school- or district-wide installation, you deploy SMART Sync Teacher software to all
teacher computers and SMART Sync Student software to all student computers. As a system
administrator, you install SMART Sync Class List Server to connect teacher and student computers
and create a SMART School file with SMART Administrator Tools - Classlist Manager to centralize
teacher, student and class information as well as application and Internet blocking rules.

Teacher

SMART 

School 

File

SMART Sync 

Teacher

Student

SMART Sync 

Student

Network

SMART Sync 

Class List 

Server

Administrator

SMART 

Administrator 

Tools -

Classlist 

Manager

Teacher

SMART Sync 

Teacher

Student

SMART Sync 

Student

Student

SMART Sync 

Student

Student

SMART Sync 

Student

Student

SMART Sync 

Student

Student

SMART Sync 

Student

I   I MPORTANT

SMART Administrator Tools - Classlist Manager is beneficial for centrally managing teacher,
student and class information across a school or district.

Install SMART Sync Class List Server and SMART Administrator Tools - Classlist Manager and
create a SMART School file before you install SMART Sync Teacher software and SMART Sync
Student software. This enables you to connect SMART Sync Teacher software to the
SMART School file and SMART Sync Student software to SMART Sync Class List Server during
installation rather than having to do somanually after installation.
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Installing SMART Sync Class List Server
In a typical school- or district-wide installation, you install SMART Sync Class List Server on a server
or other computer on your school’s or district’s network that all teacher and student computers can
access.

g To install SMART Sync Class List Server

1. Go to smarttech.com/administratordownloads.

2. Scroll toSMART Sync classroommanagement software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Follow the on-screen instructions to download the SMART Sync Administrator Tools
executable file.

4. Double-click the executable file, and then follow the on-screen instructions.

5. In the component installation step of the wizard, select theSMART Sync Class List Server
check box and clear the other check box.

6. Click Install.

Windows Installer installs SMART Sync Class List Server.

Installing and using SMART Administrator Tools -
Classlist Manager
SMART Administrator Tools - Classlist Manager allows you to create SMART School files.

A SMART School file contains information about students, teachers, classes and computer labs in
your school as well as rules that teachers can apply to block student access to applications and
websites. If you specify the location of a SMART School file in SMART Sync Teacher software,
teachers can use this information to populate their classes.

In most situations, you only need to create one SMART School file per school so that all teachers and
students in the school can connect to each other. For security reasons, when you create the file, save
it in a location accessible to teachers and system administrators, but not to students. After creating
the file, you can update it.
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Installing SMARTAdministrator Tools - Classlist Manager
In a typical school- or district-wide installation, you install SMART Administrator Tools - Classlist
Manager on one or more system administrator computers.

g To install SMART Administrator Tools - Classlist Manager

1. Go to smarttech.com/administratordownloads.

2. Scroll toSMART Sync classroommanagement software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Follow the on-screen instructions to download the SMART Sync Administrator Tools
executable file.

4. Double-click the executable file, and then follow the on-screen instructions.

5. In the component installation step of the wizard, select theSMART Administrator Tool
check box and clear the other check box.

6. Click Install.

Windows Installer installs SMART Administrator Tools - Classlist Manager.

Using information from third-party applications
If youmanage school information using a third-party application, youmight be able to export the
school information to a comma separated values (CSV) file to use it in your SMART School file.

The information that the CSV file contains depends on how computers are used in your school.

Creating a CSV file for schools with individual computers
If each student has his or her own laptop or assigned computer in a class, create a CSV file that
contains student, teacher and class information.

EXAMPLE

PersonID,LastName,FirstName,Title,ClassID,ClassTitle,Type

S001,Adams,John,,Eng,English,0

S002,Brook,Sally,,Eng,English,0

S003,Williams,Ronald,,Eng,English,0

T001,Johnson,Adam,Mr.,Eng,English,1
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I   I MPORTANT

If a teacher or student is in multiple classes, the CSV file must contain multiple lines for that
teacher or student (one for each class).

g To create a student, teacher and class CSV file

1. Export student, teacher and class information from the third-party application to a CSV file.

N   NOTE

See the third-party application’s Help for instructions.

2. Open the CSV file usingMicrosoft® Excel® or another application that can open CSV files.
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3. Ensure the CSV file contains the following columns:

Column name Type Description
PersonID String The student’s or teacher’s unique ID.

I   I MPORTANT

o The ID you enter heremust match the ID the
student uses to log on to SMART Sync Student
software.

o The ID must be unique to the student or teacher.
For example, a student and a teacher can’t both
have the ID 123456.

LastName String The student’s or teacher’s last name.
FirstName String The student’s or teacher’s first name.
Title String The teacher’s title (for example,Mr.,Ms. orDr.).

N   NOTE

SMART Administrator Tools - Classlist Manager only
stores this information for teachers.

ClassID String The unique ID of the student’s or teacher’s class.
ClassTitle String The name of the student’s or teacher’s class.

If appropriate, include the class’s period to distinguish it
from other classes.

Type Integer 0 for a student.
OR
1 for a teacher.

N   NOTES

o The first row of the spreadsheet must contain the column names as listed in the table
above.

o The string columns can contain any character except a comma (,).

4. Save the CSV file.
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Creating a CSV file for schools with computer labs
If your school’s computers are located in labs, create a CSV file that contains computer lab
information.

EXAMPLE

Hostname,WorkstationName,LabID,LabTitle

127.0.0.1,Main Lab WS1,Main,Main Lab

127.0.0.2,Main Lab WS2,Main,Main Lab

127.0.0.3,Main Lab WS3,Main,Main Lab

127.0.0.4,Main Lab WS4,Main,Main Lab

127.0.0.5,Main Lab WS5,Main,Main Lab

g To create a computer lab CSV file

1. Export computer lab information from the third-party application to a CSV file.

N   NOTE

See the third-party application’s Help for instructions.

2. Open the CSV file using Excel or another application that can open CSV files.

3. Ensure the CSV file contains the following columns:

Column name Type Description
Hostname String The computer’s host name or IP address (for example,

127.0.0.1).

N   NOTE

If your network uses DHCP, refer to the computer by
host name rather than by IP address.

WorkstationName String The computer’s name.
LabID String The unique ID of the computer’s lab.
LabTitle String The name of the computer’s lab.

N   NOTES

o The first row of the spreadsheet must contain the column names as listed in the table
above.

o The string columns can contain any character except a comma (,).

4. Save the CSV file.
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Creating a SMART School file
After you install SMART Administrator Tools - Classlist Manager and export information from third-
party applications to CSV files, you can create a SMART School file.

I   I MPORTANT

If you are upgrading to SMART Sync 2011 software from SMART Sync 2009 or 2010 software, do
the following:

l Create a new SMART School file following the instructions inCreating a SMART School file
above.

l Delete the teacher files of administered teachers.

InWindows XP operating system, these files are inC:\Documents and Settings\
All Users\Documents\SMART Technologies\SMART Sync

InWindows Vista andWindows 7 operating systems, these files are in
C:\Users\Public\Documents\SMART Technologies\SMART Sync
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The specific steps you complete to create a SMART School file depend on how you want to include
school information in the file.

If you want to: Complete these steps:
Create CSV files and import their
contents into a SMART School file
using the command line tool.

1. Import the contents of the CSV file using the
command line tool (see page 23).

2. Open the SMART School file in SMART
Administrator Tools - Classlist Manager (see page
21).

3. Create administered application and Internet
blocking rules (see page 27 and page 28).

4. Review the SMART School file (see page 29).

Create CSV files and import their
contents into a SMART School file
using SMART Administrator Tools -
Classlist Manager.

1. Start SMART Administrator Tools - Classlist
Manager and create a new SMART School file (see
page 21).

2. Import the contents of the CSV file using SMART
Administrator Tools - Classlist Manager (see page
22).

3. Create administered application and Internet
blocking rules (see page 27 and page 28).

4. Review the SMART School file (see page 29).

Enter school information directly in
SMART Administrator Tools -
Classlist Manager.

1. Start SMART Administrator Tools - Classlist
Manager and create a new SMART School file (see
page 21).

2. Enter school information in SMART Administrator
Tools - Classlist Manager (see page 24, page 25 and
page 25).

3. Create administered application and Internet
blocking rules (see page 27 and page 28).

4. Review the SMART School file (see page 29).

Starting SMART Administrator Tools - Classlist Manager
The first step in using SMART Administrator Tools - Classlist Manager is to create or open a
SMART School file.

g To create a SMART School file

1. Double-click theSMART Administrator Tools - Classlist Manager 2011 icon on your
desktop.

TheSMART Administrator Tools - Classlist Managerwindow appears.
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2. Click School File, click Create a new SMART School file and save it as, and then click
Browse.

TheSelect School File Location dialog box appears.

3. Browse to the folder where you want to create the SMART School file.

I   I MPORTANT

For security reasons, create the SMART School file in a location that is accessible to
teachers and system administrators but not to students. Teacher can have read-only access
to the file, but system administrators require read/write access.

4. Type a name in the File name box.

5. Click Save.

TheSelect School File Location dialog box closes, and the path to the SMART School file
appears in the box below theCreate a new SMART School file and save it as option.

g To open a SMART School file

1. Double-click theSMART Administrator Tools - Classlist Manager 2011 icon on your
desktop.

TheSMART Administrator Tools - Classlist Managerwindow appears.

2. Click School File, click Edit the existing SMART School file in this location, and then
click Browse.

TheOpen School File dialog box appears.

3. Browse to and select the SMART School file.

4. Click Open.

TheOpen School File dialog box closes, and the path to the SMART School file appears in the
box below theEdit the existing SMART School file in this location option.

Importing school information using SMART Administrator Tools - Classlist Manager
You canmanually enter student, teacher and class or computer lab information in SMART School
files using SMART Administrator Tools - Classlist Manager. Alternatively, you can generate CSV
files from a third-party application (seeUsing information from third-party applications on page 16) and
then import the contents of these files into the SMART School file using SMART Administrator Tools
- Classlist Manager as described in this section or using the command line tool as described in the
next section (see page 23).
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g To import student, teacher and class information

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Import Information.

3. Click Browse to the right of theStudent, Teacher, Class CSV file Location box.

TheOpenClasses CSV File dialog box appears.

4. Navigate to and select a student, teacher and class CSV file.

5. Click Open.

TheOpenClasses CSV File dialog box closes, and the path to the CSV file appears in the
Student, Teacher, Class CSV file Location box.

g To import computer lab information

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Import Information.

3. Click Browse to the right of theComputer, Lab CSV File Location box.

TheOpen Labs CSV File dialog box appears.

4. Navigate to and select a computer lab CSV file.

5. Click Open.

TheOpen Labs CSV File dialog box closes, and the path to the CSV file appears in the
Computer, Lab CSV File Location box.

Importing school information using the command line tool
You can import the contents of CSV files using the command line tool rather than SMART
Administrator Tools - Classlist Manager.

g To import school information

1. Open a command prompt window.

2. Open the following folder in the command prompt window:

[Program files]\SMART Technologies\SMART Administrator Tools 2011\
CSVtoSchool.exe
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3. Type the following command, and then press ENTER:

CSVtoSchool /classcsv:[Class CSV file path]

/labcsv:[Computer lab CSV file path]

/schoolfile:[SMART School file path]

Where

o [Class lab CSV file path] is the path and file name of the student, teacher and class CSV
file

o [Computer lab CSV file path] is the path and file name of the computer lab CSV file

o [SMART School file path] is the path and file name of the SMART School file.

N   NOTES

o If the SMART School file doesn’t exist, the tool creates the SMART School file and
includes the student, teacher and class or computer lab information from the CSV file
in it.

o If the SMART School file exists, the tool replaces the student, teacher and class or
computer lab information with the contents of the CSV file, but the Internet blocking
rules and application blocking rules remain the same.The database ID of the
SMART School file remains the same.

o If there are errors, a message appears, displaying an error number that indicates the
problem.

o If there are no errors, a 0 error message appears.

Entering student information
You can import student information from aCSV file (see Importing school information using SMART
Administrator Tools - Classlist Manager on page 22). Alternatively, you canmanually enter student
information in a SMART School file using SMART Administrator Tools - Classlist Manager.

N   NOTE

Student information is required only if you’re entering classes in the SMART School file (see
Entering class or computer lab information on the next page).

g To add a student

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Students, and then click Add Student.

A new row appears in the table.
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3. Type the student’s last name in the Last Name column.

4. Type the student’s first name in the First Name column.

5. Type the student’s ID in theStudent ID column.

I   I MPORTANT

The ID you enter heremust match the ID the student uses to log on to SMART Sync Student
software.

N   NOTE

SMART Administrator Tools - Classlist Manager generates a random ID for the student if you
don’t specify one.

Entering teacher information
You can import teacher information from aCSV file (see Importing school information using SMART
Administrator Tools - Classlist Manager on page 22). Alternatively, you canmanually enter teacher
information in a SMART School file using SMART Administrator Tools - Classlist Manager.

N   NOTE

Teacher information is required only if you’re entering classes in the SMART School file (see
Entering class or computer lab information below).

g To add a teacher

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Teachers, and then click Add Teacher.

A new row appears in the table.

3. Type the teacher’s last name in the Last Name column.

4. Type the teacher’s first name in the First Name column.

5. Type the teacher’s title in the Title column (for example,Mr.,Ms. orDr.).

Entering class or computer lab information
If each student has his or her own laptop or assigned computer in a class, youmust enter classes in
the SMART School file.

OR

If computers are located in labs in your school, youmust enter the labs in the SMART School file.
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You can import class or computer lab information from aCSV file (see Importing school information
using SMART Administrator Tools - Classlist Manager on page 22). Alternatively, you canmanually
enter class or computer lab information in a SMART School file using theClasses section or
Computer Labs section of SMART Administrator Tools - Classlist Manager.

g To add a class

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Classes, and then click Add.

A new row appears in the table.

3. Type a name in theClass Name column (for example, 5th Grade Math).

If appropriate, include the class’s period to distinguish it from other classes.

4. Select the name of a teacher or student you want to include in the class in the

All Students and Teachers list, and then click to move it to theClass Members list.

N   NOTES

o In theAll Students and Teachers andClass Members lists, teachers’ names appear in
red text and students’ names appear in black text.

o To remove teachers or students from a class, select their names in theClass

Members list, and then click to move them to theAll Students and Teachers list.

5. Repeat step 4 for each teacher or student that you want to add to the class.

g To add a computer lab

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Computer Labs, and then click Add.

A new row appears in the computer lab table.

3. Type a name in the Lab Name column (for example,Main Lab).

4. Click Add Computer.

A new row appears in the computer table.
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5. Type the host name or IP address of the computer in theHostname column (for example,
127.0.0.1).

N   NOTE

If your network uses DHCP, refer to the computer by host name rather than by IP address.

6. Type the name of the computer in theWorkstation Name column (for example,
Main Lab WS1).

7. Repeat steps 4 to 6 for each computer you want to add to the computer lab.

N   NOTE

To remove a computer from the computer lab, select the computer, and then click
Remove Computer.

Creating administered application blocking rules
An application blocking rule enables teachers either to allow specific applications and block all others
or to block specific applications and allow all others. For example, an English teacher could allow
access toMicrosoft Word but block access to all other applications while students are writing an
English paper.

Teachers can individually create and share application blocking rules in SMART Sync Teacher
software. Alternatively, you can create centrally administered application blocking rules and include
them in a SMART School file.

g To create a rule

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Application Blocking, and then click Add.

A new row appears in the application blocking rule table.

3. Type a name in theRule Name column (for example, English Paper).

4. Select Block all applications except those listed below to block access to all applications
except those you include in the rule.

OR

Select Allow all applications except those listed below to allow access to all applications
except those you include in the rule.

5. Click Add Application.

A new row appears in the application table.
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6. Type a name for the application in theDisplay Name column if you don’t want to use the default
name.

7. Type the path to the application in theApplication Path column.

8. SelectWindows orMac in theOperating System column.

9. Repeat steps 5 to 8 for each application you want to add to the application blocking rule.

N   NOTE

To remove an application from the application blocking rule, select the application, and then
click Remove Application.

Creating administered Internet blocking rules
An Internet blocking rule enables teachers either to allow specific websites and block all others or to
block specific websites and allow all others. For example, a history teacher could block access to
online encyclopedias and other history resources while students are writing a history paper.

Teachers can individually create and share Internet blocking rules in SMART Sync Teacher software.
Alternatively, you can create centrally administered Internet blocking rules and include them in a
SMART School file.

g To create a rule

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Internet Blocking, and then click Add.

A new row appears in the Internet blocking rule table.

3. Type a name in theRule Name column (for example, History Paper).

4. Select Block all websites except those listed below to block access to all websites except
those you include in the rule.

OR

Select Allow all websites except those listed below to allow access to all websites except
those you include in the rule.

5. Click Add Website.

A new row appears in the website table.

6. Type the address of the website in theWebsite Address column.
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7. Repeat steps 5 and 6 for each website you want to add to the Internet blocking rule.

N   NOTE

To remove a website from the Internet blocking rule, select the website, and then click
Remove Website.

Reviewing the SMART School file
After creating a SMART School file, you can review it in theSummary section and then close
SMART Administrator Tools - Classlist Manager to save the file. You should complete the following
tasks before you review and save the file:

l Import school information (see Importing school information using SMART Administrator Tools
- Classlist Manager on page 22 or Importing school information using the command line tool on
page 23).

OR

Enter student, teacher or class information (seeEntering student information on page 24,
Entering teacher information on page 25, andEntering class or computer lab information on
page 25).

OR

Enter computer lab information (seeEntering class or computer lab information on page 25).

l Create administered application blocking rules (seeCreating administered application blocking
rules on page 27).

l Create administered Internet blocking rules (seeCreating administered Internet blocking rules
on the previous page).

g To review the SMART School file

1. Start SMART Administrator Tools - Classlist Manager (seeStarting SMART Administrator
Tools - Classlist Manager on page 21).

2. Click Summary.

If any warnings appear, read them and take the appropriate actions.

3. Click Exit.

Installing teacher and student software
After you install SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager and creating a SMART School file, you can install SMART Sync Teacher software on
teacher computers and SMART Sync Student software on student computers.
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Installing teacher and student software across a school or district involves three steps:

1. Locating the installation files

2. Customizing the installation packages

3. Deploying the installation packages

Installation packages and supporting files
Before you can customize or deploy SMART software, youmust locate the installation packages and
supporting files.

Installation packages
There are three installation packages (also known as MSI files) for SMART Sync software:

Installation package File name
SMART Sync Teacher software SMART Sync Teacher 2011.msi
SMART Sync Student software SMART Sync Student.msi
SMART Administrator Tools SMART Administrator Tools 2011.msi

Download these installation packages from smarttech.com/administratordownloads.

Save the packages in a location on your network that’s accessible to all computers on which you plan
to install the software.

Language files
If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
correspondingMST file for the language is in the same folder as theMSI file (see Installation
language files and codes on page 61).

Customizing the installation packages
Before you deploy installation packages, you can customize them for your environment by creating
MST files.

I   I MPORTANT

If you installed SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager and created a SMART School file, customize the SMART Sync Teacher software
installation package to reference the SMART School file location and the SMART Sync Student
software installation package to reference the SMART Sync Class List Server location.
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You can createMST files using SMART Install Manager (see page 41).

OR

You can createMST files using a third-party tool such as Orca database editor and theWindows
Installer properties (see page 51).

Deploying the software
You can deploy installation packages using the command line interface.

OR

You can deploy installation packages using third-party imaging or remotemanagement software.

N   NOTE

Youmight need tomanually activate the software after you deploy it.

Using the command line interface
Using the command line interface, you can deploy installation packages inmany ways, including
running commands from the Command Prompt window and including commands in batch script files.

I   I MPORTANT

Before you deploy the SMART Sync Teacher software installation package, youmust install
Windows Installer 4.5 (see support.microsoft.com/kb/942288).

g To install SMART Sync Teacher software

Run the following command if you created anMST file to customize the installation package:

msiexec /i "[Path]\SMART Sync Teacher 2011.msi" TRANSFORMS="[MST

file]" [Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation package:

msiexec /i "[Path]\SMART Sync Teacher 2011.msi" [Properties]

[Parameter]

Where

l [Path] is the path to theSMART Sync Teacher 2011.msi file andMST file.

l [MST file] is the name of theMST file.
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l [Properties] is a set of properties you can include to customize the installation (see
SMART Sync Teacher software installation package on page 51).

I   I MPORTANT

If you installed SMART Administrator Tools - Classlist Manager and created a
SMART School file, include theSCHOOLFILE and theENABLE_ADMINISTERED_
CLASSLIST properties.

l [Parameter] is the installation parameter (seeParameters on page 59).

g To install SMART Sync Student software

Run the following command if you created anMST file to customize the installation package:

msiexec /i "[Path]\SMART Sync Student.msi" TRANSFORMS="[MST file]"

[Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation package:

msiexec /i "[Path]\SMART Sync Student.msi" [Properties] [Parameter]

Where

l [Path] is the path to theSMART Sync Student.msi file andMST file.

l [MST file] is the name of theMST file.

l [Properties] is a set of properties you can include to customize the installation (see
SMART Sync Student software installation package on page 53).

I   I MPORTANT

If you installed SMART Sync Class List Server include the
SYNC_NAMINGSERVERLOC property.

l [Parameter] is the installation parameter (seeParameters on page 59).

Using third-party imaging or remote management software
The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remotemanagement software, see the software’s documentation.
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N   NOTE

This proceduremay vary depending on your version of Windows operating system and your system
preferences.

g To deploy an installation package

1. Copy theMSI file and theMST file to \\[Domain Controller]\NETLOGON, where
[Domain Controller] is your domain controller.

2. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

TheActive Directory Users and Computers window appears.

3. Right-click your domain, and then select Properties.

TheProperties dialog box appears.

4. Click theGroup Policy tab, and then click Edit.

TheGroup Policy Object Editor dialog box appears.

5. Browse to and openComputer Configuration\Software Settings.

6. Right-click Software Installation, select New > Package, and then browse to and select the
MSI file from step 1.

7. In theDeploy Software section, click Advanced, and then click OK.

8. Click theModifications tab, click Add, and then browse to and select theMST file from step
1.

9. Click OK to apply theMST file to theMSI file.

10. Close all open windows and dialog boxes.

The next time each computer on the domain starts, the computer automatically installs the
software in Silent mode with the customizations defined in theMST file.
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This chapter explains how tomodify or remove SMART software.

Modifying the software
After installing SMART Sync Administrator Tools on a computer, youmay decide to add or remove
components. For example, youmay have installed SMART Sync Class List Server on the same
computer you now want to install SMART Administrator Tools - Classlist Manager on.

g To add a component

Run the following command:

msiexec /i "[Path]\SMART Administrator Tools 2011.msi" [Installation

property] [Add properties] /q

Where:

l [Path] is the path to theSMART Administrator Tools 2011.msi file.

l [Installation property] is the INSTALL property of the component already installed.
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l [Add properties] is the set of properties for the component you want to add:

Components Add Properties
SMART Sync Class
List Server

INSTALLCLASSLISTSERVER="1" REINSTALLMODE=voums

ADDLOCAL=ClassListServer

SMART Administrator
Tools - Classlist
Manager

INSTALLADMINTOOL="1" REINSTALLMODE=voums

ADDLOCAL=AdminTool

SeeComponent addition examples below for more information.

g To remove a component

Run the following command:

msiexec /i "[Path]\SMART Administrator Tools 2011.msi" [Remove

properties] /q

Where:

l [Path] is the path to theSMART Administrator Tools 2011.msi file.

l [Remove properties] is the set of properties for the component you want to remove:

Components Remove Properties
SMART Sync Class
List Server

INSTALLCLASSLISTSERVER="" REINSTALLMODE=voums

REMOVE=ClassListServer

SMART Administrator
Tools - Classlist
Manager

INSTALLADMINTOOL="" REINSTALLMODE=voums

REMOVE=AdminTool

SeeComponent removal examples on the next page for more information.

Component addition examples
The following example installs SMART Administrator Tools - Classlist Manager on a computer that
already has SMART Sync Class List Server:

msiexec /i "C:\SyncSetup\SMART Administrator Tools 2011.msi"

INSTALLCLASSLISTSERVER=1 INSTALLADMINTOOL=1 REINSTALLMODE=voums

ADDLOCAL=AdminTools /qb
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The following example installs SMART Sync Class List Server on a computer that already has
SMART Administrator Tools - Classlist Manager:

msiexec /i "C:\SyncSetup\SMART Administrator Tools 2011.msi"

INSTALLADMINTOOL=1 INSTALLCLASSLISTSERVER=1 REINSTALLMODE=voums

ADDLOCAL=ClassListServer /qb

Component removal examples
The following example removes SMART Sync Class List Server:

msiexec /i "C:\SyncSetup\SMART Administrator Tools 2011.msi"

INSTALLCLASSLISTSERVER="" REINSTALLMODE=voums REMOVE=ClassListServer

/qb

The following example removes SMART Administrator Tools - Classlist Manager:

msiexec /i "C:\SyncSetup\SMART Administrator Tools 2011.msi"

INSTALLADMINTOOL="" REINSTALLMODE=voums REMOVE=AdminTool /qb

N   NOTE

You can also remove SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager following the instructions in To remove SMART Sync Class List Server and SMART
Administrator Tools - Classlist Manager on page 39.

Removing the software
You can remove SMART software using the command line interface.

OR

You can remove SMART software using third-party imaging or remotemanagement software.

Using the command line interface
Using the command line interface, you can remove SMART software in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

I   I MPORTANT

Only remove the common platform after removing all other SMART software.
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g To remove SMART Sync Teacher software

Run the following command to remove the software using the installation package:

msiexec /x "[Path]\SMART Sync Teacher 2011.msi" [Parameter]

Where

l [Path] is the path to theSMART Sync Teacher 2011.msi file.

l [Parameter] is the installation parameter (seeParameters on page 59).

OR

Run the following command to remove the software using the product code:

msiexec /x [Product code] [Parameter]

Where

l [Product code] is the product code for the version of SMART Sync Teacher software you’re
removing, including the braces (“{” and “}”).

Version Product code
7.0.27.1 {0BA04E3D-ACE5-4706-B252-2D126EC0FAAE}
7.0.44.2 {0BA04E3D-ACE5-4706-B252-2D126EC0FAAE}
8.1.92.6 {96E3501E-D006-4D78-8FD6-C6C00CD8919A}
8.1.107.7 {E721B9EF-DBCA-4356-892E-93B98A019F1B}
9.0.37.2.0 {72B08261-5E61-47A5-8C75-A8B8C4A44E7A}
10.0 {9D81615E-B150-488B-90CA-1159E2113BE3}
10.0 (chained) {F5F5DBE0-1238-477C-963C-BE6C305A1C5F}

l [Parameter] is the installation parameter (seeParameters on page 59).

g To remove SMART Sync Student software

Run the following command to remove the software using the installation package:

msiexec /x "[Path]\SMART Sync Student.msi" [Parameter]

Where

l [Path] is the path to theSMART Sync Student.msi file.

l [Parameter] is the installation parameter (seeParameters on page 59).

OR
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Run the following command to remove the software using the product code:

msiexec /x {896E88BE-1052-4944-930E-43C1C8AE354C} [Parameter]

Where [Parameter] is the installation parameter (seeParameters on page 59).

g To remove SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager

Run the following command to remove the software using the installation package:

msiexec /x "[Path]\SMART Administrator Tools 2011.msi" [Parameter]

Where

l [Path] is the path to theSMART Administrator Tools 2011.msi file.

l [Parameter] is the installation parameter (seeParameters on page 59).

OR

Run the following command to remove the software using the product code:

msiexec /x {7062B1A8-9483-49B0-A4E6-639459C1BB67} [Parameter]

Where [Parameter] is the installation parameter (seeParameters on page 59).

g To remove the common platform

If you installed the common platform using theSMART Common Platform.msi file, run the
following command to remove the software using the installation package:

msiexec /x "[Path]\SMART Common Platform.msi" [Parameter]

Where

l [Path] is the path to theSMART Common Platform.msi file.

l [Parameter] is the installation parameter (seeParameters on page 59).

OR

Run the following command to remove the common platform using the product code:

msiexec /x {0E5DD7A3-BE29-430C-970B-C553F4A58C39} [Parameter]

Where [Parameter] is the installation parameter (seeParameters on page 59).
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Using third-party imaging or remotemanagement software
The following procedure shows how to remove SMART software usingWindows operating systems’
Group Policy-based deployment software. For information on removing software using your
organization’s third-party imaging or remotemanagement software, see the software’s
documentation.

N   NOTE

This proceduremay vary depending on your version of Windows operating system and your system
preferences.

g To remove a deployed installation package

1. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

TheActive Directory Users and Computers window appears.

2. Right-click your domain, and then select Properties.

TheProperties dialog box appears.

3. Click theGroup Policy tab, and then click Edit.

TheGroup Policy Object Editor dialog box appears.

4. Browse to and openComputer Configuration\Software Settings\
Software Installation.

5. Right-click the software you want to remove, and then select All Tasks > Remove.

6. Select Immediately uninstall the software from users and computers, and then click OK.

The next time each computer on the domain starts, the computer automatically removes the
software.
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Chapter 5: Using SMART Install Manager
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Customizing the SMART Sync Teacher software installation package 44
Customizing the SMART Sync Student software installation package 45

SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishingMST files. You can then deploy theMSI andMST files to
computers using third-party imaging or remotemanagement software.

Installing SMART Install Manager
Download and install SMART Install Manager from the SMART Support website.

g To install SMART Install Manager from the website

1. Go to smarttech.com/administratordownloads.

2. Scroll toSMART Sync classroommanagement software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Click Administrator Downloads, and then click SMART Install Manager.

4. Save the Install Manager.exe file to your computer.

5. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.
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Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu underAll Programs > SMART Technologies > SMART Install Manager.

With SMART Install Manager, you can do the following:

l Open and customize an installation package.

l Save your changes to the installation package as an XML file.

l Publish your changes to the installation packages as anMST file.

Opening an installation package
To customize an installation package, drag its MSI file into the SMART Install Manager window.

N   NOTE

You can customize only theSMART Sync Teacher 2011.msi andSMART Sync Student.msi
files with SMART Install Manager.

Alternatively, you can search for installation packages on your computer by clicking .

N   NOTE

All installation packages you’ve previously opened in SMART Install Manager appear in the
Unmodified Packages tab.
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

Saving your changes
After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening theMSI file and then selecting File > Import.

Publishing your changes as anMST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as anMST file. To do this, select File > Publish, and then use the dialog box to define a
location for and create theMST file.

T   T I P

Publish theMST file in the same location as theMSI file.
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Customizing the SMART Sync Teacher software
installation package
To customize the SMART Sync Teacher software installation package, open theSMART Sync
Teacher 2011.msi file in SMART Install Manager (seeUsing SMART Install Manager on page 42),
and then set the controls on each page.

Control Procedure Notes
Installation Options
Installation
directory

Type the path to your preferred folder
for SMART Sync Teacher software.

If you don’t specify a folder, Windows
Installer installs SMART Sync
Teacher software in [Program
files]\SMART
Technologies\Education Software
where [Program files] is C:\Program
Files for 32-bit versions of Windows
operating systems orC:\Program File
(x86) for 64-bit versions of Windows
operating systems.

Product Key
Product key Type your 22-character product key for

SMART Sync software.
You can type the product key with or
without hyphens.
When you type a volume product key,
the software activates when you
deploy it to your network computers.

Administrator Setup
Administer class
lists using a
SMART School
file

Select to administer class lists using a
SMART School file, and then type the
path to the SMART School file in the
File location box or click Browse, and
then browse to and select the
SMART School file.

Before you can specify the path to a
SMART School file, youmust install
SMART Administrator Tools -
Classlist Manager, and then use it to
create the SMART School file.

Connect students
using SMART
Sync Classlist
Server

Select to connect students using
SMART Sync Class List Server, and
then type the host name or IP address
for SMART Sync Class List Server in
theHostname or IP address box.
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Customizing the SMART Sync Student software
installation package
To customize the SMART Sync Student software installation package, open theSMART Sync
Student.msi file in SMART Install Manager (seeUsing SMART Install Manager on page 42), and
then set the controls on each page.

Control Procedure Notes
Installation Options
Installation
directory

Type the path to your preferred folder
for SMART Sync Student software.

If you don’t specify a folder, Windows
Installer installs SMART Sync Student
software in [Program files]\SMART
Technologies\Sync Studentwhere
[Program files] is C:\Program Files
for 32-bit versions of Windows
operating systems orC:\Program File
(x86) for 64-bit versions of Windows
operating systems.

Install Start menu
and desktop
shortcuts

Select to create shortcuts in the Start
menu and on the desktop.

Student Configuration Settings: Interface
Visible to students Select to show the SMART Sync

Student software user interface to the
student.

Hidden from
students

Select to hide the SMART Sync
Student software user interface from
the student.

If you select this option, the student
won’t be able to do the following:

l Connect to a teacher by
selecting his or her name from a
list

l Manually start SMART Sync
Student software

l Manually enter an ID after
starting SMART Sync Student
software
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Control Procedure Notes
Student Configuration Settings: Connection with Teacher
Allows the student
to select from a
list of available
teachers

Select to allow the student to select a
teacher from a list.

This option is disabled if you select
Hidden from student in the Interface
page.
In addition, if you select
Hidden from student but don’t select
one of the three options below and
provide a teacher ID, host name or IP
address, the student will not be able to
connect to a teacher.

Automatically
connects with this
Teacher ID

Select to connect SMART Sync
Student software to a specific teacher
through the teacher’s ID.
Type the ID in the box below the
option.

Automatically
connects with this
host name or IP
address

Select to connect SMART Sync
Student software to a specific teacher
through the host name or IP address.
Type the host name or IP address in
the box below the option.

If your network uses DHCP, refer to
the computer by host name rather than
by IP address.

Automatically
connects with
classes the
student belongs to

Select to connect SMART Sync
Student software to the classes the
student belongs to.

Uses this Class
List Server host
name or IP
address

Select to connect SMART Sync
Student software to a specific teacher
using SMART Sync Class List Server.
Type the host name or IP address of
the SMART Sync Class List Server
computer in the box below the check
box.

If your network uses DHCP, refer to
the computer by host name rather than
by IP address.

Student Configuration Settings: Options
Start
SMART Sync
Student
automatically…

Select to start SMART Sync Student
software when the student first logs
on.

This check box is disabled if you
select Hidden from student in the
Interface page.

Ask questions Select to allow the student to ask
questions.

This check box isn’t visible if you
select Hidden from student in the
Interface page.

Chat Select to allow the student to chat with
other students.

This check box isn’t visible if you
select Hidden from student in the
Interface page.
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Control Procedure Notes
Submit files Select to allow the student to submit

files.
This check box isn’t visible if you
select Hidden from student in the
Interface page.

Exit the Student
program

Select to allow the student to close
SMART Sync Student software.

This check box isn’t visible if you
select Hidden from student in the
Interface page.

Student Configuration Settings: Student ID
Student
Controlled

Select to allow the student to enter an
ID when SMART Sync Student
software starts.

This option is disabled if you select
Hidden from student in the Interface
page.
If you select this option, SMART Sync
software doesn’t apply Internet and
application blocking rules until after the
student enters an ID and joins the
class.

The following Select to enter a specific student ID.
Type the ID in the box below the
option.

This option is best if students use the
same computer everyday or if you
want to give computers names.

Found in this
Active Directory
field…

Select to find the student ID in an
Active Directory field of the student’s
login account.
Type the Active Directory field name in
the box to the right of the option.

Anonymous Select to allow the student to use
SMART Sync Student software
without entering an ID.

Select this option if students change
computers or if user privacy is
required.

Student Configuration Settings: Shared Files Folder
My Documents
folder

Select to store files the teacher shares
with the student in theMy Documents
folder (Windows XP orWindows 7
operating systems) orDocuments
folder (Windows Vista operating
system).

Custom folder Select to store files in another folder.
Type the path to the folder in the box
below the option.
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Appendix A: Recommended computer and
network settings
Display settings 49
Network size and speed 50
Internet connection firewalls 50

Before you install SMART Sync software, configure your computers and network for optimal
performance as documented in this appendix.

Display settings
SMART Sync software works best when the teacher and student computers are set to the same
screen resolution and color depth. However, the softwaremakes adjustments for different color
settings and resolutions. For example, if a broadcasting computer (either teacher or student) runs at a
higher resolution than a viewing computer, scroll bars appear on the viewing computer so you can
view the entire higher-resolution screen.

Similarly, if a broadcasting computer has a higher color setting than a viewing computer, the
broadcasting computer’s colors are reduced so the viewer can see it on his or her computer. For
example, if a student’s computer has a higher color setting than the teacher’s computer, the teacher
sees aColor Reducedmessage below the thumbnail. When the teacher views a live, full-screen
image of the student’s desktop, the colors appear slightly degraded.

For information on how to change the display settings of your school’s monitors, see the
documentation for the operating system.
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Refer to the following table for the optimal screen resolution and color depth for your school’s
monitors.

Color depth/screen resolution High color (16-bit) True color (32-bit)
1024 × 768 or lower Optimal Optimal
1152 × 864 Acceptable Acceptable
1280 × 1024 Acceptable Acceptable
1600 × 1200 Acceptable Not recommended

Network size and speed
The preferred TCP/IP network configuration for SMART Sync software is a switch or a switching hub
that restricts network traffic to a particular segment of your local area network. In this configuration,
other network traffic doesn’t affect your system and SMART Sync software doesn’t slow down other
segments of the network. Network activity is faster when the number of connected students is
smaller.

Network type Maximum number of students
100Mbps 80
Wireless (single 802.11 a/g access point) 30
Wireless (single 802.11 n access point) 35

T   T I P

Graphics-rich backgrounds on student screens can slow SMART Sync software performance.
Performance is best if student screens have simple, single-color backgrounds.

Internet connection firewalls
If you install SMART Sync software on a computer that has an active Internet connection firewall, the
firewall can cause network problems. If possible, set the firewall to allow network traffic from
SMART Sync software. If this doesn’t resolve the problem, ensure the following network
communication ports are open:

Port Type Purpose
5463 TCP Main teacher to student communications port
5485 TCP Main teacher to teacher communications port
5496 UDP Teacher discovery port
5493 UDP Broadcast port
46200 TCP SMART Sync Class List Server

46201 TCP SMART classroom coordinator port (local host only)
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Appendix B: Windows Installer properties and
parameters
Properties 51

SMART Sync Teacher software installation package 51
SMART Sync Student software installation package 53
SMART Sync Administrator Tools installation package 57

Parameters 59

Properties

SMART Sync Teacher software installation package
The following are properties for the SMART Sync Teacher software installation package:

Property Allowed values Notes
General properties
INSTALLDIR [String]: The path to your preferred

folder for SMART Sync Teacher
software.

If you don’t specify a folder, Windows
Installer installs SMART Sync
Teacher software in [Program
files]\SMART
Technologies\Education Software
where [Program files] is C:\Program
Files for 32-bit versions of Windows
operating systems orC:\Program
File (x86) for 64-bit versions of
Windows operating systems.

SYNC_PROD_
KEY

[String]: The 22-character product key
you received from SMART.

This property automatically populates
theProduct Key box in the activation
wizard if you choose not to include the
ACTIVATE_LICENSE property.
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Property Allowed values Notes
TRANSFORMS [String]: A languageMST file for the

installation (see Installation language
files and codes on page 61).

Ensure the specifiedMST file is in the
same folder as theMSI file.
This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software uses
the computer’s operating system
language if it’s supported, or English
(U.S.) if not.
You can also use the TRANSFORMS
property to apply anMST file created
by SMART Install Manager (see page
41) or a third-party tool.

SMART Sync Teacher software properties
ENABLE_
ADMINISTERED_
CLASSLIST

1: Administer class lists using a
SMART School file.
[Null or empty string] (default): Don’t
administer class lists using a
SMART School file.

If you want to administer class lists
using a SMART School file, youmust
install SMART Administrator Tools -
Classlist Manager, use it to create the
file, and then specify the path to the
file using the SCHOOLFILE property.

SCHOOLFILE [String]: The path to the
SMART School file.

ENABLE_
CONNECT_
STUDENTS_
USING_CLS

1: Connect students using
SMART Sync Class List Server.
[Null or empty string] (default): Don’t
connect students using SMART Sync
Class List Server.

If you want to connect students using
SMART Sync Class List Server, you
must install SMART Sync Class List
Server, and then specify the host
name or IP address in the SYNC_
NAMINGSERVERLOC property.

SYNC_NAMING
SERVERLOC

[String]: The host name or IP address
of SMART Sync Class List Server.
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SMART Sync Student software installation package
The following are properties for the SMART Sync Student software installation package:

Property Allowed values Notes
General properties
INSTALLDIR [String]: The path to your preferred

folder for SMART Sync Student
software.

If you don’t specify a folder,
Windows Installer installs
SMART Sync Student software in
[Program files]\SMART
Technologies\Sync Student
where [Program files] is
C:\Program Files for 32-bit
versions of Windows operating
systems orC:\Program File (x86)
for 64-bit versions of Windows
operating systems.

TRANSFORMS [String]: A languageMST file for the
installation (see Installation
language files and codes on page
61).

Ensure the specifiedMST file is in
the same folder as theMSI file.
This property defines the language
of the installer’s user interface and
the installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software
uses the computer’s operating
system language if it’s supported,
or English (U.S.) if not.
You can also use the
TRANSFORMS property to apply
anMST file created by
SMART Install Manager (see page
41) or a third-party tool.

LOCALE [Integer]: A language code for
SMART Sync Student software
(see Installation language files and
codes on page 61).

If you don’t specify a language
code using LOCALE,
SMART Sync Student software
uses the computer’s operating
system language if it’s supported,
or English (U.S.) if not.

A PPEN D I X B

Windows Installer properties and parameters

53



Property Allowed values Notes
SMART Sync Student software properties
CREATE_
SHORTCUTS

1 (default): Include shortcuts to
SMART Sync Student software in
the Start menu and on the desktop.
[Empty string]: Don’t include
shortcuts to SMART Sync Student
software in the Start menu and on
the desktop.

SYNC_VISIBLE 1 (default): Show the SMART Sync
Student software user interface.
0: Hide the SMART Sync Student
software user interface.

SYNC_
CONNECTUSED

0: Allow the student to select a
teacher from a list.
1: Connect SMART Sync Student
software to a specific teacher using
SMART Sync Class List Server.
2: Connect SMART Sync Student
software to a specific teacher
through the teacher’s ID defined in
SYNC_CONTEACHID.
3: Connect SMART Sync Student
software to a specific teacher
through the host name or IP address
defined in SYNC_CONNECTIP.

If you set SYNC_VISIBLE to 0,
youmust set this property to 1, 2 or
3.

SYNC_
CONTEACHID

[String]: A teacher ID to which
SMART Sync Student software will
connect automatically.

SYNC_
CONNECTIP

[String]: A teacher host name or IP
address to which SMART Sync
Student software will connect
automatically.

SYNC_
USENAMINGSERVER

1: Specify a SMART Sync Class
List Server to connect to in the
SYNC_NAMINGSERVERLOC
property.
0: Don’t specify a SMART Sync
Class List Server.

SYNC_NAMING
SERVERLOC

[String]: A SMART Sync Class List
Server host name or IP address to
which SMART Sync Student
software will connect automatically.
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Property Allowed values Notes
SYNC_
AUTOSTART

1 (default): Start SMART Sync
Student software when the student
first logs on.
0: Don’t start SMART Sync Student
software when the student first logs
on.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_ENABLE
QUESTIONS

1 (default): Allow the student to ask
questions.
0: Don’t allow the student to ask
questions.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
ENABLECHAT

1 (default): Allow the student to chat
with other students.
0: Don’t allow the student to chat
with other students.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
ENABLEFILE
TRANSFER

1 (default): Allow the student to
submit files.
0: Don’t allow the student to submit
files.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
DISPLAYEXIT

1: Allow the student to close
SMART Sync Student software.
0: Don’t allow the student to close
SMART Sync Student software.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
STUDIDMODE

0: Use a student ID found in an
Active Directory field specified in
SYNC_ACTDIRSTUDID.
1: Use a student ID specified in
SYNC_STUDENTID.
2: Allow the student to enter an ID
when SMART Sync Student
software starts.
3: Allow the student to use
SMART Sync Student software
without entering an ID.

If you set SYNC_VISIBLE to 1,
this property’s default value is 2. (If
this property’s value is 2,
SMART Sync software doesn’t
apply Internet and application
blocking rules until after the student
enters an ID and joins the class.)
If you set SYNC_VISIBLE to 0,
this property’s default value is 1. In
this situation, youmust include
SYNC_STUDENTID.
Set this property to 3 if students
change computers or if user privacy
is required.

SYNC_
ACTDIRSTUDID

[String]: The name or ID of an Active
Directory field that contains the
student’s ID.

If you include this property, SYNC_
STUDIDMODE is set to 0
automatically.

SYNC_
STUDENTID

[String]: A student ID. If you include this property, SYNC_
STUDIDMODE is set to 1
automatically.

A PPEN D I X B

Windows Installer properties and parameters

55



Property Allowed values Notes
SYNC_
CUSTSHRD
FOLDER

[Null or empty string] (default): Store
files the teacher shares with the
student in theMy Documents folder
(Windows XP andWindows 7
operating systems) orDocuments
folder (Windows Vista operating
system).
[String]: Store files the teacher
shares with the student in another
folder specified in this property.
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SMART Sync Administrator Tools installation package
The following are properties for the SMART Sync Administrator Tools installation package:

Property Allowed values Notes
General properties
TRANSFORMS [String]: A languageMST file for the

installation (see Installation language
files and codes on page 61).

Ensure the specifiedMST file is in the
same folder as theMSI file.
This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software uses
the computer’s operating system
language if it’s supported, or English
(U.S.) if not.
You can also use the TRANSFORMS
property to apply anMST file created
by SMART Install Manager (see page
41) or a third-party tool.

SPU properties
INSTALL_SPU 1 (default): Install SPU in Full mode.

2: Install SPU in Dashboardmode.
0: Don’t install SPU.

In Full mode, users can view currently
installed versions of SMART software
and their product keys, and download
and install updates.
In Dashboardmode, users can view
only currently installed versions of
SMART software and their product
keys.
SPU doesn’t check for updates to
SMART Sync software. However, it
does check for updates to other
installed SMART products.

SPU_TIME_
FRAME

[Integer]: The time in days (1 to 60)
between SPU checks.

By default, SPU checks for product
updates every 30 days.
This property is applicable only if you
install SPU.

PRODUCT_
NOTIFICATION

1 (default): Notify the user when
updates are available from SPU.
0: Don’t notify the user when updates
are available from SPU.

This property is applicable only if you
install SPU.
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Property Allowed values Notes
SMART Sync Administrator Tools properties
INSTALL
CLASSLIST
SERVER

1: Install SMART Sync Class List
Server.
[Null] (default): Don’t install
SMART Sync Class List Server.

INSTALL
ADMINTOOL

1: Install SMART Administrator Tools
- Classlist Manager.
[Null] (default): Don’t install SMART
Administrator Tools - Classlist
Manager.

ENABLE_
ASSISTED_
TEACHER_
DISCOVERY

1: Use assisted teacher discovery.
0: Don’t use assisted teacher
discovery.

SYNC_NAMING
SERVERLOC

[String]: A SMART Sync Class List
Server host name or IP address for
assisted teacher discovery.

ENABLE_
ADMINISTERED_
CLASSLIST

1: Use administered class lists.
0: Don’t use administered class lists.
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Parameters
The following are the standardWindows Installer parameters for themsiexec command.

Parameter Use
/q Hide the installation wizard.

N   NOTE

This is Silent mode.

/qb Show a basic installation wizard.
/qb! Show a basic installation wizard without aCancel button.
/qb+ Show a basic installation wizard with a dialog box signaling the end of the

installation.
/qb+! Show a basic installation wizard without aCancel button but with a dialog box

signaling the end of the installation.
/qr Show a reduced installation wizard.
/qf Show the full installation wizard, including a dialog box signaling the end of the

installation or the Fatal Error, User Exit orExit dialog box.
/qn Hide the installation wizard and the dialog box signaling the end of the

installation.
/qn+ Hide the installation wizard but show the dialog box signaling the end of the

installation.
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Appendix C: Installation language files and
codes
Language Code File
English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Arabic 1025 1025.mst
Chinese (Traditional) 1028 1028.mst
Chinese (Simplified) 2052 2052.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
Dutch 1043 1043.mst
Finnish 1035 1035.mst
French (France) 1036 1036.mst
German 1031 1031.mst
Greek 1032 1032.mst
Hungarian 1038 1038.mst
Italian 1040 1040.mst
Korean 1042 1042.mst
Norwegian 1044 1044.mst
Polish 1045 1045.mst
Portuguese (Portugal) 2070 2070.mst
Portuguese (Brazil) 1046 1046.mst
Russian 1049 1049.mst
Spanish (Spain) 1034 1034.mst
Spanish (Mexico) 2058 2058.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst
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Active Directory directory service 10, 47, 55
administrator computers 2
application blocking rules 27
applications
in SMART Sync 3
rules for blocking 27

Arabic 61

B
blocking rules
application See application blocking

rules
Internet See Internet blocking rules

browsers See web browsers
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chat 10
checklist i
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color quality 2, 49
command line interface 31, 35, 37
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removing 36

computer labs 26
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Student 8

CSV files 16, 22
Czech 61
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display settings 49
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exit 10
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IDs
student See student IDs
teacher See teacher IDs

importing information 22
Install Manager See SMART Install

Manager
installation checklist i
installation types 3
installation wizards 6, 16
installing
Administrator Tool 16
student software 29
teacher software 29

Internet blocking rules 28
Internet Explorer Internet browser 2
IP addresses 9
Italian 61

K
Korean 61

L
labs See computer labs
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language setup 52-53, 57

M
MSI files 30
MST files 43, 52-53, 57, 61
My Documents folder 10

N
network adapters 9
network requirements 2, 50
Norwegian 61

P
parameters 59
Polish 61
ports 50
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product key 51
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Q
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quit 10

R
RAM 2
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rules
application blocking See application

blocking rules
Internet blocking See Internet blocking
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Russian 61

S
screen resolutions 2, 49
serial number See product key
shortcuts 54
Silent mode 59
SMART Install Manager
about 41
downloading 41
installing 41
using 42

SMART Product Update 57
SMART School files 15, 52
SMART Sync Administrator Tool 3, 16
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SMART Sync Class List Server 3, 9
SMART Sync Student 3
SMART Sync Teacher 3
software See applications
Spanish 61
spreadsheet software 16
Start menu icons 54
student computers 2
student IDs 10, 25
student information 24
Swedish 61
SyncClient.ini file 11

T
TCP traffic 50
teacher computers 2
teacher discovery 9
teacher IDs 9
teacher information 25
third-party applications 16, 32, 40
Turkish 61

U
UDP 50
uninstalling 36
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Windows Installer 51
Windows operating systems 2
wireless support 50
wizards See installation wizards
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